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What Is the Clipboard?
The Windows Clipboard is a temporary storage location you use when you want to exchange 
information between documents. The Clipboard is available to all applications you are running with 
Windows.
The data exchange can be made within the same application or between applications. You can 
exchange information between a Windows application and a non-Windows application and between the 
various Windows modes.
In addition to transferring information, you can view the contents of the Clipboard and save the contents 
to a files.

Related Procedures



Concepts
Using the Clipboard with Windows Applications
Windows Modes

Procedures
Saving Clipboard Files
Viewing the Clipboard Contents



How Does the Clipboard Work?
Suppose you are creating a flyer for the company picnic. You composed the text for the invitation in your
word processing application and drew a map in your drawing application. 
Instead of printing both pieces and then cutting the map and pasting it into the invitation with scissors 
and glue, you can do it electronically, like this:

Keep in mind that you do not need to start the Clipboard when you want to place information on the 
Clipboard or paste from the Clipboard. In the above example, you would choose Paintbrush's Copy 
command, and the map would be automatically placed on the Clipboard. In Write, you would then 
choose Paste, and the map would be automatically pasted from the Clipboard.
You can paste the information into the destination whenever you want, and you can paste the 
information repeatedly. The Clipboard retains its contents until you:

Cut or copy another piece of information.
Clear the Clipboard.
Exit from Windows.

You can also capture an entire screen or an entire window of information. The Clipboard takes a 
"snapshot" that it converts to a bitmap file (.BMP). When pasting information captured in this way, make 
sure the destination can recognize the .BMP format.

Related Procedures



Procedures
Copying, Cutting, and Pasting with Windows Applications
Copying with Non-Windows Applications
Copying the Window or Screen with Non-Windows Applications
Pasting into a Full-Screen, Non-Windows Application
Pasting into a Windowed, Non-Windows Application



Using the Clipboard with Windows Applications
When you use Windows applications, you can cut or copy selected information onto the Clipboard. You 
can also copy an image of the entire desktop or of a single window.
Windows applications recognize text, graphics, or both. The Clipboard will hold the information without 
changing its format. 
When you paste the information, the second application determines its format. Make sure that the 
application you want to paste into will recognize the information you want to paste. 
For example, Word for Windows can use text and graphics. You can select and copy both to the 
Clipboard. If you paste both into Notepad, Notepad does not paste the graphic. Notepad recognizes only
text.

Related Procedure



Using the Clipboard with Non-Windows Applications
The method you use to cut and paste with non-Windows applications depends on which mode Windows 
is using.

In standard or real mode, you can only copy the entire screen. You can paste graphics or unformatted
text into the non-Windows application.
In 386 enhanced mode, you can copy selected text or graphics, a window, or the entire screen. You 
can paste graphics or unformatted text.

NOTE: To find out which mode you are using, choose About Program Manager from the Program 
Manager Help menu.

Related Procedures



Procedures
Copying with Non-Windows Applications
Copying the Window or Screen with Non-Windows Applications
Pasting into a Full-Screen, Non-Windows Application
Pasting into a Windowed, Non-Windows Application



Using the Clipboard in Standard or Real Mode
When you are running a non-Windows application in standard or real mode, you can:

Copy only the entire screen to the Clipboard.
Paste unformatted text into the non-Windows application.
Paste graphics into non-Windows applications that recognize bitmap files (.BMP).

Related Procedures



Procedures
Copying with Non-Windows Applications
Copying the Window or Screen with Non-Windows Applications
Pasting into a Full-Screen, Non-Windows Application



Using the Clipboard in 386 Enhanced Mode
Since you can run a non-Windows application in a window on the desktop, you can copy selected text or
graphics, a window, or the entire screen onto the Clipboard.    
The Control menu for any non-Windows application you are running in a window has special Edit 
commands you use for selecting information and for copying it onto the Clipboard.
When you copy text or graphics, the Clipboard holds unformatted text or bitmapped graphics (.BMP). 
You can paste the information into any application that will recognize the .BMP format.
When you paste text into a non-Windows application, the Clipboard cannot paste text formats. All 
formatting will be lost.

Related Procedures



hint
Pressing ALT+ENTER toggles a non-Windows application between running full-screen and running in its 
own window on the desktop.



Viewing and Saving Information on the Clipboard
The Windows Clipboard is always running in the background, ready to store whatever you transfer. You 
can open the Clipboard by choosing its icon from the Main Group in Program Manager.

Viewing
With the Clipboard open, you can view its contents to make sure you captured the exact information you
want to transfer.
The Clipboard displays its contents in the formats supported by the original application. Some 
applications support more that one format. If so, you can view the Clipboard contents in the supported 
formats when you open the Clipboard.

Saving
With the Clipboard open, you can save the contents to a file, and then retrieve the file to view or paste 
later. A file saved in this way is a Clipboard file and can be read only by the Clipboard application.

Related Procedures



Procedures
Saving Clipboard Files
Viewing the Clipboard Contents in Other Formats













Open Command

Opens a Clipboard file and shows the contents in the Clipboard window.
Use this command to load text or an image that you previously saved as a Clipboard file. Once the file is
loaded onto the Clipboard, you can view the contents or paste them into a document.

Related Procedure



Save As Command

Saves the Clipboard contents in a file.
Use this command to save text or an image you later might want to retrieve and paste from the 
Clipboard into a document.

Related Procedure



Exit Command

Exits the Clipboard and closes the Clipboard window.



Delete Command

Deletes the contents of the Clipboard window.
If you need more memory to run an application, you can clear the Clipboard contents with this 
command. Since the Clipboard stores information in multiple formats, you might free memory by clearing
the Clipboard contents.

Related Procedure



Auto Command

Displays the Clipboard contents in the format used when the contents were placed on the Clipboard.
Use Auto to view the contents in their original format after changing them with one of the format names 
on the Display menu.

Related Procedure



Format Names

Displays the Clipboard contents in a specified format.
Choosing one of the format names on the Display menu changes the format of the Clipboard contents. 
Use this feature to view the contents in another format.
Changing formats does not affect the format the Clipboard uses when it pastes the contents into an 
application. The Clipboard uses the format most appropriate for the application.

Related Procedure
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Copying, Cutting, and Pasting with Windows Applications
Information you cut or copy onto the Clipboard remains there until you clear the Clipboard, cut or copy 
another piece of information onto it, or exit from Windows. Since the Clipboard retains its contents until 
you change them, you can paste the information into the destination whenever you want, and you can 
paste the same information repeatedly.
The Cut, Copy, and Paste commands found in most Windows applications let you copy or move 
information within a document, between documents, or between applications. You can also copy an 
image of the entire screen or a single application window.

To copy or move information:
1 Select the text, the graphics, or a combination of the two.

For procedures on selecting information, see Help for the application you're using.
2 Choose Copy or Cut from the Edit menu.

The Cut command removes the information from the application and places it on the Clipboard.
The Copy command places a copy of the information on the Clipboard, leaving the original 
information unchanged.

3 Place the insertion point where you want the information to appear.
Or select text you want to replace.
Or move to another document or application. Then place the insertion point or select text.
Some Windows applications recognize text files, others recognize graphics, and several recognize 
text and graphics. The Paste command will be unavailable if the application does not recognize the 
format of the information.

4 Choose Paste from the Edit menu.
Windows copies the information to the location marked by the insertion point or replaces selected text
with the information.

To copy the contents of the active window onto the Clipboard:
Press ALT+PRINT SCREEN.    
Windows takes a "snapshot" of the active window and places it on the Clipboard.
ALT+PRINT SCREEN creates a bitmap of the active window. Not all applications can read bitmaps files 
(.BMP). Make sure the application you want to paste information into can recognize the bitmap 
format.

To copy the contents of the entire screen onto the Clipboard:
Press PRINT SCREEN.    
Windows takes a "snapshot" of the screen contents and places it on the Clipboard.
PRINT SCREEN creates a bitmap of the entire screen. Not all applications can read bitmaps files 
(.BMP). Make sure the application you want to paste information into can recognize the bitmap 
format.

Keyboard Procedure



hint
If ALT+PRINT SCREEN does not work, try SHIFT+PRINT SCREEN. Older keyboards might not recognize 
ALT+PRINT SCREEN.



hint
If the procedure does not copy the screen onto the Clipboard, your keyboard is probably an older, 
unenhanced model. Try the following key combinations to copy the screen: ALT+PRINT SCREEN or 
SHIFT+PRINT SCREEN.



Copying with Non-Windows Applications
When running a non-Windows application in a window, you can copy selected information onto the 
Clipboard. (To run a non-Windows application in a window, you must run Windows in 386 enhanced 
mode. If you are running Windows in standard mode or real mode, a non-Windows application can run 
full-screen only.)    
Information you cut or copy onto the Clipboard remains there until you clear the Clipboard, cut or copy 
another piece of information onto it, or exit from Windows.

To copy selected information:
1 Drag the mouse pointer across the information you want to copy.
2 Open the Control menu and choose Edit.

A cascading menu opens.
3 Choose Copy.

Related Procedures Keyboard Procedure



Procedures
Pasting into a Full-Screen, Non-Windows Application
Pasting into a Windowed, Non-Windows Application



hint
If you aren't sure which mode Windows is running in, open the Program Manager window and choose 
About Program Manager from the Help menu.



Copying the Window or Screen with Non-Windows Applications
When running a non-Windows application in a window, you can copy the window or the entire screen 
onto the Clipboard. When running a full-screen application, you can copy only the entire screen onto the 
Clipboard. (To run a non-Windows application in a window, you must run Windows in 386 enhanced 
mode. If Windows is running in standard mode or real mode, a non-Windows application can run full-
screen only.)    
Information you cut or copy onto the Clipboard remains there until you clear the Clipboard, cut or copy 
another piece of information onto it, or exit from Windows.

To copy the contents of the active window onto the Clipboard:
Press ALT+PRINT SCREEN.    
Windows takes a "snapshot" of the active window and places it on the Clipboard.
ALT+PRINT SCREEN creates a bitmap of the entire screen. Not all applications can read bitmaps files 
(.BMP). Make sure the application you want to paste information into can recognize the bitmap 
format.

To copy the contents of the entire screen onto the Clipboard:
Press PRINT SCREEN.    
Windows takes a "snapshot" of the screen contents and places it on the Clipboard.
PRINT SCREEN creates a bitmap of the entire screen. Not all applications can read bitmaps files 
(.BMP). Make sure the application you want to paste information into can recognize the bitmap 
format.
This procedure works only for non-Windows applications that are not running in graphics mode.

Related Procedures Keyboard Procedure



Procedures
Pasting into a Full-Screen, Non-Windows Application
Pasting into a Windowed, Non-Windows Application



Pasting into a Full-Screen, Non-Windows Application
You can paste only unformatted text into a non-Windows application. If you paste formatted text, the 
formatting will be lost.

To paste into a full-screen application:
1 Copy the information onto the Clipboard.
2 Start or select the destination application.
3 Place the insertion point where you want the information to appear.
4 Press ALT+ESC to shrink the non-Windows application to an icon.

The non-Windows application appears as an icon at the bottom of the Windows desktop.
5 Click the icon of the destination application to open its Control menu.
6 Choose Paste.

Or select the Edit cascading menu from the Control menu if you are running the application in 386 
enhanced mode. Then choose Paste.
The information is pasted into the destination one character at a time, as if you were typing it.

Keyboard Procedure



Pasting into a Windowed, Non-Windows Application
You can paste only unformatted text into a non-Windows application. If you paste formatted text, the 
formatting will be lost.

To paste into a windowed application:
1 Copy the information onto the Clipboard.
2 Start or select the destination application.
3 Place the insertion point where you want the information to appear.
4 Open the Control menu and choose Edit.

A cascading menu opens.
5 Choose Paste.

The information is pasted into the destination one character at a time, as if you were typing it.

Keyboard Procedure



Freeing Memory by Clearing the Clipboard
If you need more memory to run an application, you can clear the Clipboard contents. Since the 
Clipboard stores information in multiple formats, you might free memory by clearing the Clipboard 
contents.

To clear the Clipboard contents:
1 Switch to (or open) the Clipboard.
2 Choose Delete from the Edit menu.
3 Click OK to confirm the deletion.

Keyboard Procedure



Viewing the Clipboard Contents
You can open the Clipboard and look at its contents. Once the Clipboard is open, you can save the 
contents to a file, retrieve Clipboard files, or remove the current Clipboard contents.

To view the Clipboard contents:
Double-click the Clipboard icon in the Main Group window in Program Manager.
The Clipboard sometimes has to change the line length of the information you copy or cut so that all 
of it is included in the Clipboard window. When you paste from the Clipboard into the destination 
application, the information you copied or cut will be intact.

Related Procedure Keyboard Procedure



Viewing the Clipboard Contents in Other Formats
The Clipboard accepts a number of different text and graphics formats. You can view the information on 
the Clipboard in any of the formats that were supplied by the original application. These formats are 
listed on the Display menu in the Clipboard.
The application you paste the information into determines which format to use. Typically, if there are 
several choices, the application chooses the format that provides the most information.

To view the Clipboard contents in another format:
Choose a format name from the Display menu.

To return to the first format that was displayed:
Choose Auto from the Display menu.

Keyboard Procedure



Saving Clipboard Files
You can save the contents of the Clipboard to a file and then open the file to view or paste later. The file 
you save can be read only by the Clipboard.

To save a file:
1 Open the Clipboard if it is not already open.
2 Choose Save As from the File menu.
3 If you want to save the file as DEFAULT.CLP, click OK.

If you want to save the file under a different name and in the current directory, type the filename, 
including a filename extension if you want to specify one.
The .CLP extension is automatically assigned to the filename if you don't specify an extension. If you 
specify an extension, it overrides any automatic extension.
If you want to save the file in a different directory, double-click its name in the Directories box. Then 
type the filename.    

4 Click OK.    

Related Procedures Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Opening Clipboard Files



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and click OK.



Opening Clipboard Files
To open a file:
1 Open the Clipboard if it is not already open.
2 Choose Open from the File menu.
3 If the file is in the current directory, double-click the name of the file in the Files box.

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
double-click the name of the file in the Files box.    

Related Procedures Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Saving Clipboard Files



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the files and directories located one level closer to a disk's root directory.
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and click OK.





To Press

Delete the selected item and place it on 
the Clipboard.

SHIFT+DEL

Insert contents from the Clipboard into 
the active window.
Or, in Terminal, send the Clipboard 
contents to the remote system.

SHIFT+INS

Make a copy of the selected text and 
place it on the Clipboard.

CTRL+INS

Copy the contents of the entire screen 
onto the Clipboard.

PRINT SCREEN

Copy the contents of the active window 
onto the Clipboard.

ALT+PRINT 
SCREEN
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Keyboard: Copying, Cutting, and Pasting with Windows Applications
To copy or cut information:
1 Select the information. Then press CTRL+INS to copy information or press SHIFT+DEL to cut information.

Or press ALT+PRINT SCREEN to copy the active window.
Or press PRINT SCREEN to copy the entire screen.

2 Place the insertion point where you want the information to appear.
Or move to another document or application. Then place the insertion point.

3 Press SHIFT+INS.

Related Topics Mouse Procedure



Keys
Movement Keys

Procedure
Selecting Text



Keyboard: Copying with Non-Windows Applications
To copy selected information:
1 Press ALT+SPACEBAR.
2 Press E.
3 Press K.
4 Use the ARROW keys to move the insertion point to the first character you want to select.
5 Press SHIFT+ARROW keys to select the information.
6 Press ALT+SPACEBAR.
7 Press E.
8 Press Y.

Related Procedures Mouse Procedure



Procedures
Pasting into a Full-Screen, Non-Windows Application
Pasting into a Windowed, Non-Windows Application



Keyboard: Copying the Window or Screen with Non-Windows Applications
To copy the contents of the active window or the entire screen onto the Clipboard:

Press ALT+PRINT SCREEN to copy the window.
Or press PRINT SCREEN to copy the entire screen.

Related Procedures Mouse Procedure



Procedures
Pasting into a Full-Screen, Non-Windows Application
Pasting into a Windowed, Non-Windows Application



Keyboard: Pasting into a Full-Screen, Non-Windows Application
To paste into a full-screen application:
1 Copy the information onto the Clipboard.
2 Start or select the application.
3 Place the insertion point where you want the information to appear.
4 Press ALT+ESC to shrink the non-Windows application to an icon.
5 Press ALT+ESC until you select the destination application's icon.
6 Press ALT+SPACEBAR.
7 Press P.

Or type E and then type P if you are running the application in 386 enhanced mode.

Related Procedures Mouse Procedure



Procedures
Selecting Windows or Icons
Starting Applications



Keyboard: Pasting into a Windowed, Non-Windows Application
To paste into a windowed application:
1 Copy the information onto the Clipboard.
2 Start or selects the application.
3 Place the insertion point where you want the information to appear.
4 Press ALT+SPACEBAR.
5 Press E.
6 Press P.

Related Procedures Mouse Procedure



Procedures
Selecting Windows or Icons
Starting Applications



Keyboard: Freeing Memory by Clearing the Clipboard
To clear the Clipboard contents:
1 Switch to (or open) the Clipboard.
2 Press ALT and then E.
3 Press D.
4 Press ENTER to confirm the deletion.

Mouse Procedure



Keyboard: Viewing the Clipboard Contents
To view the Clipboard contents:

Choose the Clipboard icon from the Main Group window in Program Manager.

Related Procedure Mouse Procedure



Keyboard: Viewing the Clipboard Contents in Other Formats
To view the Clipboard contents in another format:
1 Press ALT and then D.
2 Press the underlined letter associated with a format name.

To return to the first format in which the Clipboard contents were displayed:
1 Press ALT and then D.
2 Press A.

Mouse Procedure



Keyboard: Saving Clipboard Files
To save a file:
1 Open the Clipboard if it is not already open.
2 Press ALT and then F.
3 Press A.
4 If you want to save the file as DEFAULT.CLP, press ENTER.

If you want to save the file under a different name and in the current directory, type the filename, 
including a filename extension if you want to specify one.
If you want to save the file in a different directory, press ALT+D and use the UP ARROW or DOWN ARROW 
key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

5 Press ENTER.    

Related Procedure Mouse Procedure



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and press ENTER.



Keyboard: Opening Clipboard Files
To open a file:
1 Open the Clipboard if it is not already open.
2 Press ALT and then F.
3 Press O.
4 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

5 Press ENTER.    

Related Procedures Mouse Procedure



Procedures
Browsing Through the Directories List Box
Saving Clipboard Files



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the files and directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and press ENTER.







Clipboard
A temporary storage location you use when you want to exchange information between documents. The 
Clipboard is available to all applications you are running with Windows.



application Control-menu



title bar          
Contains the title of the application running in the window, in this case the Clipboard.

Drag the title bar to move the window.



Minimize button          
Click the Minimize button to shrink the Clipboard window to an icon.



Maximize button          
Click the Maximize button to enlarge the Clipboard window to its maximum size.



File menu



Edit menu



Display menu



Help menu



menu bar          
Contains the names of all the Clipboard menus.

Click a menu name to display commands.



scroll arrow          

An arrow on either end of a scroll bar used to move the contents of the window or list box into view.
Click a scroll arrow to move the contents into view.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box for moving the contents of the window or list 
box.

Click a scroll bar to move the contents one screen.



scroll box          

A box used to move quickly to a particular location in a file or list.
Drag the scroll box to move to another location.



Clipboard contents          

Shows the text or graphics you copied onto the Clipboard. Once on the Clipboard, the contents are 
ready to be pasted into another application.



application window
The main window for an application, in this case the Clipboard window. The Clipboard application 
window can contain text or graphics copied from another application.



window border          
The outside edge of a window.

Drag the window border to change the size of the window.







A
386 enhanced mode
active
active printer
animation
application
application icon
application window
arrow keys
associate
AUTOEXEC.BAT



B
<< button
>> button
Back button
base-level synthesizer
batch file
baud rate
bitmap
branch
browse
byte



C
cascading menu complementary color
CD-ROM compound device
channel CONFIG.SYS
check box Contents button
choose Control menu
Clipboard Control-menu box
close conventional memory
collapse cutout
command
command button
command line



D
data bits Directory Tree window
default button directory window
default printer disk-drive icon
desktop display box
desktop pattern document
destination directory document file
device contention document window
device driver DOS
dialog box drag
directory path drop-down list box
Directory Tree



E
error-checking
expand
expanded memory
extended memory
extended synthesizer
extension



F
file
file information line
flow control
font
font size
format
full-screen application



G
General MIDI Mode standard
group
group icon
group window



H
History button
hotspot
hue
HyperGuide button bar



I
icon
insertion point
International MIDI Association



J
No defined terms.



K
keymaps
keyword
kilobyte



L
list box
local printer
local queue
luminosity



M
maximize MIDI Mapper
Maximize button MIDI sequencer
Media Control Interface MIDI Manufacturer's Association (MMA)
memory minimize
menu Minimize button
menu bar movie file
menu command MSCDEX
menu name multimedia extensions
menu title Multimedia PC
MIDI multitasking
MIDI file



N
network printer
network queue
network server
non-Windows application



O
open
option button



P
parity print option
palette printer-driver file
patch printer font
patchmaps printer queue information line
pathname program file
picture elements program information file (PIF)
pixels program item
playlist program item icon
pointer
port



Q
No defined terms.



R
RGB components
read-only
real mode
Restore button
root directory



S
sample serial port
saturation shortcut key
scaled font size shrink
screen font simple device
screen saver solid color
scroll arrow source directory
scroll bar spin box
scroll box standard mode
Search button status bar
select stop bits
selection cursor synthesizer



T
Task List
text box
text file
title
title bar
topic
track



U
Up button



V
vector font
virtual memory
volume label



W
waveform
WAVE format
wildcard characters
window
window border
Windows application
wrap



X
No defined terms.



Y
No defined terms.



Z
No defined terms.



386 enhanced mode
Provides access to the virtual memory capabilities of the Intel 80386 processor. With virtual memory 
capabilities, Windows applications can use more memory than is physically available. Enhanced mode 
also allows for multitasking of non-Windows applications.



active
Describes the selected window or icon that you are currently working with. Windows always applies the 
next keystroke or command you choose to the active window. If a window is active, it appears in front of 
all other windows on the desktop, and its title bar changes color to differentiate it visually from other 
windows. If an icon is made active, its Control menu appears.
Inactive is the opposite of active and describes windows or icons on the desktop that are not selected.



active printer
An installed printer that has been assigned to a printer port using Setup or Control Panel. More than one
printer can be set up to work on a single port, but only one can be active, since only one printer can be 
physically connected to the port at a time.
An inactive printer is an installed printer that is not currently connected to the printer port.



animation
The display of a series of graphic images, simulating motion. You can play animation files (for example, 
files with the.MMM extension) with the Media Player accessory. Animations are also called movies.



application
A computer program used for a particular kind of work, such as word processing. This term is often used
interchangeably with "program."



application icon          

An icon that represents an application that is running.



application window
The main window for an application. It contains the application's menu bar and main workspace. An 
application window may contain multiple document windows.



arrow keys          

The four arrow keys on your computer keyboard. These keys move the cursor or pointer on your screen 
to locations you choose. Each arrow key moves the cursor or pointer in the direction of the arrow on the 
key. Each arrow key is named for the direction in which arrow points: UP ARROW, DOWN ARROW, LEFT 
ARROW, and RIGHT ARROW.



associate
To assign files that have the same extension to a program. When you choose a file with the specified 
extension, the associated application runs with the file loaded.



AUTOEXEC.BAT
Batch file that lists MS-DOS commands. MS-DOS automatically carries out the commands in your 
AUTOEXEC.BAT file when you turn on your computer. The file is located in the root directory of your first
hard disk, which is usually drive C.
Typically, an AUTOEXEC.BAT file starts memory-resident utilities such as a network and sets up 
environment variables that are used later by applications. In addition, your AUTOEXEC.BAT file might 
set your MS-DOS prompt or start pop-up programs such as Borland's SideKick.



<< button          

Displays the previous topic in a series of topics, until you reach the first topic in the series. Then the 
button is dimmed. Use this button when you want to backtrack through topics the way they are 
organized in HyperGuide.



>> button          

Displays the next topic in a series of topics, until you reach the last topic in the series. Then the button is
dimmed. Use this button to move from topic to topic in the recommended order.



Back button          

Displays the last topic you viewed. HyperGuide moves back one topic at a time, in the order in which 
you viewed them.



base-level synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



batch file
A file that runs a sequence, or "batch," of commands when you type its filename. All filenames of batch 
files end with the extension .BAT, even though you don't have to type this extension to run the batch file.



baud rate
Signalling speed measured by the number of signals per second.



bitmap          

An image stored as an array of bits.



branch          

A segment of the Directory Tree, representing a directory and any subdirectories it contains.



browse
To look through files and directories. In some dialog boxes, the Browse button shows a list of files and 
directories from which you can choose.



byte
The amount of memory space (normally 8 bits) that a computer needs to represent a single character or 
word.



cascading menu          

A menu that opens from a command on another menu.



CD-ROM
Compact Disc-Read Only Memory. An optical data-storage technology that allows large quantities of 
data (such as animations, images, music, and sound) to be stored on a compact disc similar to discs 
used by the music industry.



channel
MIDI uses channels to send messages to individual devices within a MIDI setup. There are 16 MIDI 
channel numbers. Devices in a MIDI setup can be directed to respond only to messages marked with a 
channel number specific to the device.



check box           

A small square box that appears in dialog boxes and can be selected or cleared. When the check box is 
selected, an X appears in the box.



choose
To use key combinations or your mouse to carry out a command in Windows. You often choose a 
command after you have selected an item or made it active.



Clipboard          

A temporary storage area in memory, used to transfer information. You can cut or copy information onto 
the Clipboard and then paste it into another document or application.



close
To reduce a document window or application window to an icon or, in some cases, to remove it from the 
desktop. You close a window by double-clicking the Control-menu box or choosing the Close command 
from the Control menu. When closing an application window, you can choose to save or abandon 
changes to the current document before you close it.



collapse
To hide a level of directory information in the Directory Tree window. When you first start File Manager, 
all directories but the root directory are collapsed.



command          

A word or phrase, usually found in a menu, that you choose to carry out an action.



command button          

A button in a dialog box that carries out or cancels the selected action. Two common command buttons 
are OK and Cancel. The button that carries out the action will often have a label that describes it (for 
example, Open, Create, Install). Another dialog box appears when you choose a command followed by 
ellipses.



command line
Information given to MS-DOS that specifies a command and all the pertinent information to carry it out. 
For example, to start Windows, you type win at the MS-DOS prompt.



complementary color
The color exactly opposite a color on the RGB color wheel. For example, the complementary color of 
blue is yellow.



compound device
Devices, such as the waveform audio driver, that have an associated file and require a filename 
specification when opened.



CONFIG.SYS
A file that defines device drivers and specifies your MS-DOS configuration. For example, a typical 
CONFIG.SYS file might specify the location of the MS-DOS file COMMAND.COM, define an extended 
memory manager, and specify how many files an application can have open at once. MS-DOS runs the 
commands in the CONFIG.SYS file each time you turn on your computer. Your CONFIG.SYS file is 
located in the root directory of your first hard disk, which is usually drive C.



Contents button          

Displays the HyperGuide contents.



Control menu          

The menu in the upper-left corner of a window. The Control menu appears on every application that runs
in a window and on some non-Windows applications. Document windows, icons, and some dialog boxes
also have Control menus.
Control menu commands move, change the size of, and close windows. You can also switch to Task List
by using the Control menu. For non-Windows applications, Control menu commands transfer 
information and perform other functions, depending on the application.



Control-menu box
The box located in the upper-left corner of a window. Clicking the Control-menu box opens the Control 
menu for the window.



conventional memory
The first 640K of memory that MS-DOS uses to run applications. Most computers have at least 256K of 
conventional memory and can accommodate up to 640K of conventional memory.



cutout          
A portion of a Paintbrush drawing you select with the Scissors or Pick tool.



data bits
The bits in each package of data sent between two computers during telecommunication. Most 
characters are transmitted in 7 or 8 data bits.



default button          

The command button in some dialog boxes that is automatically selected or chosen by Windows as the 
most logical or safest choice. The default button has a bold border, indicating that it will be chosen if you 
press ENTER. You can override a default button by choosing Cancel or another command button.



default printer
The printer that Windows applications automatically use when you choose the Print command. You can 
have only one default printer, which must also be the active printer on the port. The printer you use most 
often should be made the default printer.



desktop
The background of your screen, on which windows, icons, and dialog boxes appear.



desktop pattern
A geometric pattern that appears across your desktop. You can design your own pattern or choose one 
of the patterns provided by Windows.



destination directory
The directory to which you intend to copy or move one or more files.



device contention
When several applications simultaneously request use of a peripheral device, such as a printer or 
modem.
Windows automatically handles device contention when all the applications are Windows applications. 
When one of the applications is a non-Windows application, however, the conflict is handled according 
to the options you select in the 386 Enhanced dialog box. This dialog box appears when you choose the 
386 Enhanced icon in Control Panel.



device driver
Tells Windows how to control a piece of hardware. Using Control Panel, you can install device drivers for
your:

Display (monitor)

Keyboard

Mouse

Network



dialog box          

A rectangular box that either requests or provides information. Many dialog boxes present options that 
you must choose from before Windows can carry out a command. Some dialog boxes present warnings 
or explain why a command can't be completed.



directory path          

The directions to a directory or file within your system.
In the illustration, C:\ART stands for the ART directory on drive C. Any commands you use affect the files
and subdirectories in this directory.
When you want to specify a file, make sure the filename follows the directory path.



Directory Tree          

A graphic display of a disk's directory structure. The directories on the disk are shown as branching from
the disk's root directory.



Directory Tree window          

A File Manager window that shows the complete branching structure of the selected disk drive.



directory window          

A File Manager window that lists the contents of a specific directory. The directory window shows all the 
files and subdirectories contained in the directory.



disk-drive icon          

An icon in the Directory Tree window of File Manager that represents a disk drive on your system. 
Different icons depict floppy disk drives, hard disk drives, RAM drives, CD-ROM drives, and network disk
drives.



display box          

A display box is not an option, but a type of text box that shows an example of another option you have 
selected, in this case a sample of the 10 pt, underlined, Helvetica font.



document
Whatever you create with an application, including information you enter, edit, view, or save. A document
can be a business report, a spreadsheet, a picture, and so on.



document file          

Files that are associated with an application. You can start an application and open the associated file by
choosing a document file icon.



document window          

A window inside an application window. Each document window contains a single document or other 
data file. There can be more than one document window inside an application window.



DOS
Disk Operating System, typically known as MS-DOS (Microsoft) or PC-DOS (IBM). This is the underlying
software that must exist for your PC to operate.



drag
A mouse move. You drag a Windows element by pointing to it, holding down the mouse button, and 
sliding the mouse from one spot on the surface of your desk to another and releasing the mouse button.



drop-down list box
A list box that opens and closes in dialog boxes.
Before you open a drop-down list box, it looks like this:

After the list box is open, it looks like this:

NOTE: When the list is longer than the box, scroll bars are provided.



error checking
A method for validating transmissions.



expand
To show hidden directory levels in the Directory Tree. With File Manager, you can expand a single 
directory level, one branch of the Directory Tree, or all branches at once.



expanded memory
Memory in addition to conventional memory that is available to applications. It is allocated in 16K blocks.
Windows makes use of expanded memory only if the /r switch is used at startup. Windows running in 
386 enhanced mode simulates expanded memory for the applications that need it. Windows running in 
standard mode or 386 enhanced mode allows applications to use expanded memory, but does not use 
expanded memory itself in managing applications.



extended memory
Memory in addition to conventional memory that is not readily accessible to MS-DOS or MS-DOS 
applications. Extended memory cannot be used on 8086 and 8088 computers. Windows running in 
standard mode or 386 enhanced mode uses extended memory to manage and run applications.



extended synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



extension
Part of a file or directory name that appears after a period and provides additional information. It usually 
indicates the type of file or directory. For example, program files have default extensions of .COM 
or .EXE .
Many applications include a default extension automatically when you save a file the first time. For 
example, Notepad adds a .TXT extension to all filenames unless you specify otherwise.



file
A document or application that has been given a name. All documents are stored as files in Wiindows.



file information line          

Information specific to each file in a print queue. The information can include these details:

The file's position in the 
queue or a printer icon if the file is printing.

The title of the print job 
assigned by the application (if your network software supports this).

What percentage of the 
file has printed so far.

The size of the file in 
kilobytes (if the Print File Size command on the View menu is selected).



The time and date you 
sent the file to Print Manager (if the Time/Date Sent command on the View menu is selected).

If you are connected to a network printer, the printer queue information line shows the network server 
connection. Any detailed information the network can provide appears in the message box at the upper-
right corner of the Print Manager window. Networks can provide varying degrees of detailed information.



flow control
The method for controlling the flow of information.



font          
A graphic design applied to all numerals, symbols, and characters in the alphabet. A font usually comes 
in different sizes and provides different styles, such as bold, italic, and underlining for emphasizing text.



font size
The height of a printed character, measured in points. One inch equals 72 points. For example, 12-point 
Helv is 12 points high.

The font and font size you use determine the amount of text that fits on one page. 



format
(1) The appearance of text on the pages of a document. (2) To prepare a disk so it can hold information. 
Formatting a disk erases all information that was previously on it.



full-screen application
A non-Windows application that uses the entire screen--rather than a window--to run in the Windows 
environment.



General MIDI Mode standard
A MIDI specification controlled by the MIDI Manufacturers Association (MMA). The purpose of this 
specification is to enable MIDI file authors to create files that sound the same across a variety of 
different synthesizers.



group
A collection of applications within Program Manager. Grouping your applications makes them easier to 
find.



group icon          

A group window you have reduced to an icon in Program Manager.



group window          

A window that displays the items in a group within Program Manager. These items can be applications, 
files associated with applications, or a combination of both.



History button        

Displays a list of the HyperGuide topics you have viewed. Use this button to revisit any of the last 40 
HyperGuide topics you have viewed. The most recent topic appears first.



hotspot
Text, graphics, or parts of graphics that provide links to other HyperGuide topics or more information 
about the current topic.
Whether text or graphics, the pointer changes to the shape of a hand whenever it is over a hotspot. If 
you click a hotspot that is linked to another topic, that topic will appear in the HyperGuide window. If the 
hotspot is linked to more information, HyperGuide displays the information in a popup window on top of 
the HyperGuide window.



hue
The position of a color along the color spectrum.



HyperGuide button bar          
Contains the HyperGuide buttons you use to move among topics and contents screens. It is located 
near the top of the HyperGuide window.



icon          

A graphic representation of a disk drive, directory, group, application, document, and so on. You can 
restore an application icon to a window when you want to use the application.



insertion point          
The place where text will be inserted when you type.The insertion point usually appears as a flashing 
vertical bar in an application's window or in a dialog box. The text you type appears to the left of the 
insertion point, which moves to the right as you type.



International MIDI Association (IMA)
The non-profit MIDI organization that circulates information about the MIDI specification.



keymaps
Percussion instruments are key-based--each note plays a different percussion instrument. Keymaps 
translate MIDI key values to ensure the proper percussion instruments are used to play MIDI files. All 
MIDI files for Windows are authored using standard key assignments based on the General MIDI Mode 
standard.



keyword
Words in the HyperGuide Search dialog box that are associated with topics. Each application's 
documentation has its own keyword list, including the glossary words in HyperGuide. You select from the
list of keywords or type a keyword to see the list of topics associated with that keyword.



kilobyte
The measurement used for the size of a computer's memory, where 1 kilobyte (K) = 1,024 bytes.



list box          

A box within a dialog box that lists available choices--for example, the list of all available files in a 
directory. If all the choices don't fit in the box, there will be a vertical scroll bar to the right of the list box. 
In some list boxes, you can select more than one item.



local printer
A printer that is directly connected to your printer by a cable.



local queue          

Lists the files that you directed to any active printer connected to your computer. The computer and 
printers are connected locally by a cable.
When Print Manager starts printing on a local printer, its icon appears at the bottom of your screen. If 
you restore the icon to a window, you see the print queue for any active printer connected to your 
computer. You can use the Print Manager window to check the status of files in the print queue or to 
interrupt or cancel a print job.



luminosity
The brightness of the color on a scale from black to white.



maximize
To enlarge a window to its maximum size by using the Maximize button or the Maximize command.



Maximize button          

The small button at the upper-right corner of a window that contains an Up arrow. Mouse users can click
the Maximize button to enlarge a window to its maximum size. Keyboard users can use the Maximize 
command on the Control menu.



Media Control Interface (MCI)
A standard control interface for multimedia devices and files. MCI allows a multimedia application to 
easily control a variety of multimedia devices and files.



memory
The space in a computer where information is stored while you are working with it. Most PCs have a 
small amount of read-only memory (ROM), containing the built-in programs that start the operation of 
the computer when it is turned on, and a large amount of random-access memory (RAM) for users' 
programs and data.



menu          

A list of available commands in an application window. Menu names appear in the menu bar near the 
top of the window. The Control menu, represented by the Control-menu box at the left end of the title 
bar, is common to all Windows applications. You use a command on a menu by selecting the menu 
name, then choosing the command you want.



menu bar          
The horizontal bar containing the names of an application's menus. It appears just under the title bar.



menu command          

A word or phrase in a menu that you choose to carry out an action, such as copying a file.



menu name
The name for a particular menu that appears in the menu bar and opens a menu when you choose it.



menu title
A word or phrase in the menu bar that identifies a group of commands. Selecting the menu title causes 
the title to be highlighted and its menu of commands to appear below it.



MIDI
Musical Instrument Digital Interface. MIDI sets a communications standard for transferring data between
musical instruments and associated devices.



MIDI file
A file format for storing MIDI songs. In Windows, MIDI files have a .MID filename extension. 



MIDI Mapper
A Control Panel option that lets you create and edit MIDI setup maps. Windows uses these maps to 
translate and redirect MIDI data. 



MIDI Sequencer
Software that creates or plays songs stored as MIDI files. When a sequencer plays MIDI files, it sends 
MIDI data from the file to a MIDI synthesizer that produces the sounds. Windows provides a MIDI 
sequencer to play MIDI files.



MIDI Manufacturer's Association (MMA)
A collective organization composed of MIDI instrument manufacturers and MIDI software companies. 
The MMA works with the MIDI Standards Committee to maintain the MIDI specification. 



minimize
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



Minimize button          

The small button at the upper-right corner of a window that contains a Down arrow. Mouse users can 
click the Minimize button to reduce a window to an icon. Keyboard users can use the Minimize 
command on the Control menu.



movie file
A multimedia data file (for example, a file with the .MMM extension). You can play movie files with the 
Media Player accessory. Movie files are also called animations. 



MSCDEX
Microsoft Compact Disc Extensions. MSCDEX is software that makes CD-ROM drives appear to DOS 
as network drives. You must have MSCDEX installed on your computer for the CD-ROM drive to work. 



multimedia extensions
Additional features added to Windows version 3.0 that enable your computer to run animations, play 
sound and MIDI files, and display high-quality images. 



Multimedia PC
Multimedia personal computer. A multimedia computer satisfies a minimum set of hardware/software 
requirements necessary for multimedia computing. The requirements include:

An 80286/386/486 
microprocessor running at 10MHz or faster

2MB or more of RAM

30MB or larger hard 
disk

VGA display



A digital audio 
subsystem

A CD-ROM drive

Systems software 
compatible with Microsoft Windows version 3.0 with multimedia extensions



multitasking
The ability of a single computer to perform several tasks simultaneously.
Multitasking makes it possible to print one document while editing another, or to perform lengthy 
computations while you work on something else.



network printer
A printer that is accessible to your computer only through a network.



network queue
Lists the files on the network server if you are using a network printer.



network server
A computer on a network that provides a particular service to other computers. For example, a disk 
server manages a large file server, and a print server manages a printer.



non-Windows application
An application that was not designed to run in Windows. Generally, non-Windows applications do not 
conform to Windows user-interface standards.



open
To display the contents of a directory or file in a window, or to enlarge an icon to a window.



option button           

A small round button that appears in a dialog box and is used to select an option. Within a group of 
related option buttons, you can select only one button.



palette
Defines the colors used in a bitmap image. Every device independent bitmap (DIB) has an associated 
color palette. 



parity
The method of detecting errors in data transmission.



patch
A specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as patches.



patchmaps
A patch is a specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as 
patches. Patchmaps translate MIDI patch changes to ensure the proper instruments are used to play 
MIDI files. All MIDI files for Windows are authored using standard patch assignments based on the 
General MIDI Mode standard.



pathname
The directions to a directory or file within your system. For example, C:\WINDOWS3\APPTS\JUNE.CAL 
is the pathname of the JUNE.CAL file in the APPTS subdirectory in the WINDOWS3 directory on drive 
C.



picture elements
The smallest graphics unit on the screen. Also known as pels.



pixels
The smallest graphic units on the screen. Also known as picture elements (pels).



playlist
A list of compact disc titles and tracks that determines the order in which the tracks on the disc are 
played. Playlists are only used in Music Box.
Use the Program button to assign or edit titles, and to change the playlist.



pointer          
In Windows, the shape of the pointer indicates its function.

For selecting Windows items, scrolling, resizing windows, 
and moving windows and dialog boxes with your mouse. 
This is the pointer you will see most often.

For choosing a HyperGuide hotspot.

For selecting text with your mouse.

For changing the size of a window with your mouse.

For changing the location or size of a window with your 
keyboard.

For indicating the application is processing your request.

port
A connection on a computer where you plug in a cable that carries data to a device.
LPT ports are parallel ports. COM ports are serial ports. EPT is a port used for certain printers, such as 
the IBM Personal Pageprinter. You can use the EPT port only if you have installed a special card in your 
computer.
Multimedia PCs also have a port for a MIDI sequencer.



print options
Printer-specific settings such as page orientation--portrait or landscape--or the manner in which paper 
feeds through the printer. These options vary from printer to printer.



printer-driver file
A file that gives Windows important information about how to control your printer, including details about 
printer features and the printing interface, descriptions of fonts (such as sizes and styles), character 
translations, and control sequences the printer uses to achieve various formats. Windows has printer-
driver files for most commonly used printers.



printer font
A series of dots connected by lines that can be scaled to different sizes. Another name for printer fonts is
vector (or stroke) fonts. Plotters typically use vector fonts.



printer queue information line          

Indicates the following:

The name of the printer.

Where the printer 
connects to your computer.

The current status of 
the printer.



program file          

A file that contains information that controls an application. In File Manager, each program file is 
represented by an icon. You can start the application by choosing the icon. Filenames for program files 
can have these extensions: .EXE, .COM, .PIF, and .BAT.



program information file (PIF)
A file that provides important information that Windows needs to run a non-Windows application. PIFs 
contain information such as the name of the file, a startup directory, whether the program writes directly 
to the screen or to memory, and multitasking options for applications running in 386 enhanced mode.



program item          

A program file or associated document represented by an icon in Program Manager. The program item 
provides the instructions Windows needs to start an application and open a document (if specified) when
you choose the icon.



program item icon          

An icon representing an application you can start or an associated document you can open from a group
in Program Manager. The program item provides the instructions Windows needs to start an application 
and open a document (if specified) when you choose the icon.



RGB components
The amount of each of the three primary colors--red, green, and blue--present in a color. Every color and
pattern is made by varying the three primary colors. This is true even in monochrome (black and white) 
mode. For instance, white is made by mixing together 255 parts of red, 255 parts of green, and 255 
parts of blue. Black, on the other hand, is 0 red, 0 green, and 0 blue.



read-only
Describes a file or CD-ROM disc that can only be opened and read. You cannot edit a read-only file or 
CD-ROM disc and save your changes.



real mode
An operating mode that Windows runs in to provide maximum compatibility with versions of Windows 
applications released prior to Windows version 3.0. Real mode is the only mode available for computers 
with less than 1 MB of extended memory.



Restore button          

The small button at the upper-right corner of a window that contains both an Up arrow and a Down 
arrow. The Restore button appears only after you have enlarged a window to its maximum size. Mouse 
users can click the Restore button to return the window to its previous size. Keyboard users can use the 
Restore command on the Control menu.



root directory
The main directory on a disk. The root directory is created at the first level when you format a disk. The 
symbol used to indicate the root directory of a disk is the backslash (\). For example, the root directory 
for drive C is noted as C:\.



sample
A piece of waveform data represented by a single numerical value. You convert sound into digital form 
by taking samples of the sound at specific time intervals and converting them to numeric values.



saturation
The purity of a hue, moving from gray to the pure color.



scaled font size
A font size that approximates a specified font size for use on the screen. Windows scales larger font 
sizes when a size that is available for the printer is not available for the screen. Scaled fonts may look 
slightly different from unscaled fonts. When you choose a smaller font size that is available for the printer
but not for the screen, Windows substitutes the correct size from a precision-drawn font that resembles 
the selected font as closely as possible.



screen font
A font that duplicates a printer font on your screen.

If you choose a printer font that does not have a corresponding screen font, Windows substitutes a 
screen font that closely resembles the printer font. The substitute font duplicates the line lengths and 
page breaks of the font you selected.
When you purchase extra fonts from a printer or font manufacturer, ask about the availability of screen 
fonts to match.



screen saver
An image or pattern that is shown on your computer screen during periods of inactivity. Screen savers 
hide information currently on the screen; by changing patterns they can also save wear on the 
electronics in the display.



scroll arrow          

An arrow on either end of a scroll bar that is used to scroll through the contents of a window or list box. 
Clicking a scroll arrow moves the contents one line. Holding down a scroll arrow scrolls the contents 
continuously.
Scroll arrows also control the playing of media in some applications, such as Media Player and Sound 
Recorder.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.
A scroll bar is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



scroll box          

The square or rectangular box within a scroll bar that indicates your relative position within a document 
or list box. Mouse users can drag the scroll box up or down quickly through long documents.
A scroll box is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



Search button          

Displays the keywords you can use to search for topics. Use this button to look for topics related to a 
keyword.



select
To mark an item by highlighting it with key combinations or with a mouse. Selecting does not initiate an 
action. After selecting an item, you choose the action that affects or involves the item. For example, you 
can select text and then choose the Copy command to copy the text onto the Clipboard.



selection cursor          
The marking device that shows where you are in a window, menu, or dialog box and what you have 
selected. The selection cursor appears as a dotted box around the text in a dialog box option.



serial ports
Ports used by your system, named COM1, COM2, and so on. Serial ports are typically used for 
connecting modems, mouse devices, and some kinds of printers.



shortcut key          

A key or key combination, available for some commands, that you can press to carry out a command 
without first selecting a menu. The shortcut key for a command is listed to the right of the command 
name on the menu.



shrink
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



simple device
Devices, such as audio compact-disc players, that don't have an associated file and can be opened 
without a filename specification.



solid color
A color directly supported by your display.



source directory
The directory containing the file or files you intend to copy or move.



spin box          

A spin box shows one item in a range of possible choices. Clicking the Up or Down arrow to the right of 
the entry lets you "spin" through the available choices until your choice appears in the display rectangle.



standard mode
The normal operating mode for running Windows. This mode provides access to extended memory. In 
standard mode, you can also switch among non-Windows applications.



status bar          
A line of information located at the top or bottom of a window. For example, in a directory window the 
status bar tells how many files are selected, how much disk space they occupy, and the total number of 
files in the directory. In the Directory Tree window, the status bar shows the number of bytes available on
the disk and the total disk capacity. Not all windows have a status bar.



stop bits
The timing unit between characters.
Stop bits are not actually bits; they determine the time between transmitted characters.



synthesizer
An electronic instrument able to make music and sounds by creating its own audio waveforms and 
sending them out to an audio system. A synthesizer can play back MIDI files.



Task List
A window that shows all the applications you have running so you can switch among them. You can 
open the Task List window by choosing Switch To from the Control Menu or by pressing CTRL+ESC.



text box          

A box within a dialog box where you type the information needed to carry out a command. When the 
dialog box appears, the text box may be blank or may contain text.



text file
A file containing only plain text, numbers or symbols. The text in a text file is uniform and does not 
contain any formatting, such as bold, underline, or different fonts and font sizes. A text file usually 
consists of characters coded from the ASCII character set. 
The advantage of a text file is that it can be transferred to almost any text editor or word processor. Also,
MS-DOS and Windows use text files, such as AUTOEXEC.BAT, CONFIG.SYS, and WIN.INI.



title
Another name for a software application written to run on a Multimedia PC. 



title bar          
The horizontal bar at the top of a window that contains the title of the window or dialog box. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize buttons.



topic
The level in the HyperGuide hierarchy at which you see information in the main window. This information
can be in the form of a Quick Look graphic, an explanation of a command, a conceptual overview, a 
procedure, or a table of keys. Information in pop-up windows and contents screens are not considered 
topics.



track
A sequence of sound on a CD disc, which usually corresponds to a song.



Up button          

Moves up one level in the HyperGuide hierarchy.



vector fonts
A series of dots connected by lines that can be scaled to different sizes.



virtual memory
A memory management system used by Windows running in 386 enhanced mode, which allows 
Windows to behave as if there were more memory than is actually present in the sytem. Virtual memory 
equals the amount of free RAM plus the amount of disk space allocated to a swap file that Windows 
uses to simulate additional RAM.



volume label          
The name you give a disk by using the Label command. Disk labels are optional. You see this 
information in File Manager only if you assigned a label to your disk. You can change or add a disk label 
through File Manager.



WAVE format
Microsoft's format for digitized waveform files. These files have a .WAV extension.



waveform
A sound waveform displays variances in air pressure over time. An audio signal waveform displays 
variances in voltage over time.



wildcard characters
Two MS-DOS characters you can substitute for all or part of a file or directory name when you want to 
find similarly-named files or want one command to affect a number of files or directories.
An asterisk (*) substitutes for all characters. A question mark (?) substitutes for a single character.
For example, this entry covers all files with a .DOC extension in the current directory:

*.DOC
And this entry covers everything named with FY, three other characters, and the extension .90:

FY???.90



window
A rectangular area on your screen in which you view an application or document. You can open, close, 
and move windows, and change the size of most windows. You can open several windows on the 
desktop at the same time and you can shrink windows to icons or enlarge them to fill the entire desktop.



window border          
The outside edge of a window. You can lengthen or shorten each border. You can also change the width 
of the border with Control Panel's Desktop command.



Windows application
An application that was designed for Windows and will not run without Windows. All Windows 
applications follow the same conventions for arrangement of menus, style of dialog boxes, use of the 
keyboard and mouse, and so on.



wrap
The automatic movement of the insertion point from the end of one line to the beginning of the next line 
as you type. When text wraps, you do not need to press ENTER at the end of each line in a paragraph.






